Year 8

Web Site Design

Using Dreamweaver

Before beginning this project you should copy the folder Student Re-
sources Y8 Making a Website into your own network area. Your
teacher will tell you where to find the folder on the network

Name: Group: 8.
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The aim of this project is for you to learn how to design and create a

el _’1 . website for Sha Tin College, Reviews Magazine.
T Your website should:
(gi 3 e Be suitable for the intended audience
B S e Have relevant and interesting content

Low e Have a consistent look and feel
- l“- ¢ Show features of good design

‘_ > e Use hyperlinks to navigate from page to page

TASK 1

Before you create your own web pages, you need to consider what makes an
effective website.

Open the Word file called Evaluating Internet Sites.doc that is in the folder that
you copied to your network area

o Look at the following two websites
e www.andertoons.com
¢ www.cartoonnetwork.com

LS5 Assess these websites and answer the questions in the document.

B e From your research, list 5 key points that describe a well designed website.

Print out the finished document and make sure that you put your name in the
header.
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TASK 2

Using Notepad to create a HTML webpage. Follow the instructions step by step.
Open Notepad (Programs > Accessories)

Save the file straight away as:

File name: index.htm Note ... the first page in a website is always called in-
dex.htm

Save as type: All Files (change from Text Documents)

A basic page ... (Do not type the words that are shown in Bold)

<html>
<body>
Favourite pages
</body>
</html>

Save the file -
Look at the result in a web browser What shows up on the page:

Changing text styles
<html>

<body>

<h1>Favourite pages</h1>
</body>

</html>

Save the file ‘% How has the text changed?

Look at the result in a web browser

Splitting lines

<html>

<body>

<h1l>Favourite pages</h1>
YouTube<br>
Facebook<br>
Google<br>

</body>

</html>

Save the file
Look at the result in a web browser

Adding Hyperlinks

<html>

<body>

<h1>Favourite pages</h1>

<a href="http://www.youtube.com">YouTube</a><br>
<a href="http://www.facebook.com">Facebook</a><br>
<a href="http://www.google.com">Google</a><br>
</body>

</html>

Save the file _ What colour are the links?
Look at the result in a web browser
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Adding a title to the page

[ <html>
<%~ <head>
.. <title>Links To Favourite Pages</title>

(\J </head>
. NP <body>

‘ <h1>Favourite Pages</h1>

4 F‘ <a href="http://www.youtube.com">YouTube</a><br>

| <a href="http://www.facebook.com">Facebook</a><br>
e <a href="http://www.google.com">Google</a><br>

</body>
</html>
Save the file Where does the title show up
Look at the result in a web browser on the web browser page?
Make a note of the file size of the document "“index.html” ............c.covenseuns
Y, '~ _ (Right mouse click over the file and look in Properties)
<. Set background colour (Note the spelling of colour ... color)
. <body bgcolor= ?????2?>
' ???7?27?7?is the colour as a number
Qs Each colour has a code.
e Set text colour Other colours are:
g (N <body text=7?????> FFO000 = Red
R ) EEEEOO = Yellow
P Italic text 00FF00 = Green
<i> </i> 800080 = Purple
FFFFFF = White
New paragraph 000000 = Black
<p> </p>

New paragraph aligned to left, right or center (this aligns the text to itself, not
the page)
=n = <palign=?>
+. [ Some more common HTML tags
= ABRL A <font size="6"> change to size 6 font (you can choose any size between 1 and 7)
<ul> Create a bulleted list (this tag must be put in front of each item in the list)

= .
sl F <hr> Horizontal line

To Insert a Picture
<img src="www.gif">

This tag would insert a picture with the filename www.gif
The picture you want to enter must be in the same directory as your web page.

Make a note of the file size of the document “index.html” .......cccccoeeeeei.

Checkout www.lissaexplains.com for loads of tips and tricks
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TASK 3

di [f Use a word processor to create a web pages. Using Word open a new
= document

N~
\ C Type the following:

_»uww_ Favourite Pages
F YouTube
R Facebook
Google
Highlight 'Favourite Pages’ and make it into a Heading (from the text format-
ting tools)
Highlight 'YouTube’ and from the Insert menu select Hyperlink
|ww  Typein the web page name for the site http://www.youtube.com
*1_[ "~ Repeat for the other two sites
R http://www.facebook.com
4 9 http://www.google.com
{5 Click on the yellow button on the top left of the page to save it
- o
1l Select "Other Formats” and use the file type Web Page *htm, *html (It will
P automatically open up as an interactive page)
Open your web browser and open (double click on) Favourite Pages.htm
Make a note of the file size of the document “Favourite Pages.htm”
........................ (Look in Properties)
l Now return to your Word file “Favourite Pages.htm” and from the View menu se-
L lect “"HTML Source”
B
WP Compare this HTML code with the code you wrote using Note Pad
S

o« F What do you notice? (Write some notes below)

JC STC 2/19/2008 Technology ICT 6



You are going to create pages for a new website for Sha Tin College called “Reviews”

- 9 — Magazine, which will feature the extra curricular activities that many students are in-
_I volved in within Sha Tin College.
=

J.; ~ To create these pages, you will be using a web publishing software called Adobe
— Dreamweaver CS3 (formerly Macromedia)
B =T 7

7 o TASK 4
jrlﬁf Next you will need to load Adobe Dreamweaver CS3

r—r— | 1€ first thing you must
e do is manage your site,

so follow the steps be-

ADOBE® DREAMWEAVER® C53

Site Definition

Open a Recent ltem Create New Create flom Samples I f | I
5 open T HML ‘] €35 Style Sheet OW Ca re u y .
T coldFusion T Framesst
0 e T3] Starter Fage (Theme)
T asp vBSoript T Starter Page (Basic)
0] HSLT (Ertire page) (53 More
T css

T davascript Extend
Tl

5 Dresmweaver Site

1 the g FTP or RDS, FTP or ADS
n tal

@ Dreamweaver Exchange » . the server
perations ke Ik checking or sit reports

|| Getting Started » adobe Developer Connection - New

L = ] Mew Features » w Techrical content, code, and community,
=7 BN (] Resources»
VA R
fiE

Next > Concel Help
= L] pont show susn

Site Definition for Reviews Magazine. Site Definition for Reviews Magazine 3]

e [ o |t

Site Definition < Site Definition

Editing Files, Part 3 Tes!

(Or
on
the

ColdFusion, ASP.NET. ASP. JSP. of PHF?

Whete on your computer do you want o store your fles?

C\Documents and Setingeuser\Deskiaphutkat (D &)

e e Dot e
<ot o> Dol il N X 5

T, menu bar at the top, go to Site

(" - > New Site ... )
“h[f\ j‘,”f Call the site your name followed by Reviews Magazine (e.g. MsC Reviews Magazine)

| e Next

& 1 T~ Site Definition for Reviews Magazine
n= -
[
TR S = umma;
/[ :
ks
\ . Local int
NE Wy Site
N 5 L
=+
)

te info:
Acoess: Ml et this up later,

Testing server:
Access: et this up late,

Your st can be further corfigured using the Advanced Tab.

No, I do not want to use server technology
Next

Click on the yellow folder button and find where you copied the folder to
Click Open, then Select
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TASK 5

Click on file and select New > Blank Page > click Create,
Save naming the file as “index.html”

Y |

l Pa_g_E Type: Lay_’uut: )
| HTML <none > Ll
I@ HTML template 1 column elastic, centered
= Lbrary item 1 column elastic, centered, header and
i \_b Blank Template .z: YSLT (Entire page) 1 column fixed, centered
) XSLT (Fragment) 1 column fixed, centered, header and | T
E 3 T ActionScript 1 column liquid, centered
\—ﬁ 'age from Template | = 55 1 column liquid, centered, header and {
=y JavaSaript 2 column elastic, left sidebar
ﬂ- = 2 column elastic, left sidebar, header a
j Page fiom Samele W XM 2 column elastic, right sidebar
M 2 column elastic, right sidebar, header
’ Other p (TS 23 2 column fixed, left sidebar
Th) AsPVeScpt 2 column fixed, left sidebar, header an AL document
T ASP.NETCE 2 column fixed, right sidebar
L: ASP.NET VB 2 column fixed, right sidebar, header a
T ColdFusion 2 column hybrid, left sidebar
T ColdFusion component 2 column hybrid, left sidebar, header a | DocType: YHTML 1.0 Transitional v |
't 15p 2 column hybrid, right sidebar
= PHP 2 column hybrid, right sidebar, header
- 2 column liquid, left sidebar Attach S5 file: - T
2 column liquid, left sidebar, header an -
7 2 column liquid, right sidebar bl |
| 1 . B |

What should you create? A 4 page website showing “"Reviews” Magazine

The first page “index.html” should have the school logo and a set of buttons that link
to all of the other pages (and to itself)

There should be a page for:

CAS Week

The Concert

The OSCARS

As well as the Home Page (index.html)

Inside the images folder (Student Resources Y8 Making a Website, sc_reviews) there
are

buttons for each page (2 buttons for each so you can make rollover buttons (total 8
images))

There are 3 pictures to go on each page after the Home (index) page.

Every Page must have the buttons to link to the other pages.

You will need to use at least one table on each page to position the buttons and an-
other for the pictures. Next to each picture you should write a sentence to say some-
thing about it (you can make this up) eg ... “"Here we ¢ == ma Thurman at the OSCAR
ceremony” (=

Follow the instructions carefully to creating your index page

Use tables to arrange the images and text on the page, you can create tables using

i v Properties

Farmat | one “ | Shyle Hone v BI E=E= Link | v S5
Font ._-Def.;ault. Font v Size ':.None v-.: E 8= i £= 2= Target
:j cell Harz | Default v'j W Mo wrap [] Bg | |9 D
| ;IA; vert Default v | H Header [ ] EBqg _I:J:}FFFFE.E. Erdr D
T T
cell merge cell colour _
the table but- ton you can put tables in tables or

merge cells together.

You can add colour to cells and change the cell padding
(spaces in between) in the Properties box
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Notes On Web Pages

tH (  HTML

A= =

= Hypertext Markup language ... the code used to write web pages
] (;\J . Tag ..e.g. <body> </body>... an HTML instruction code

URL
A F Uniform Resource Location (or Locator) ... the address of a web page

= When designing web pages ...
Everything is measured in pixels (the dots that make up a screen picture)

Never use capital letters in any file names and use _ (underscore) instead of
spaces

The first page must always be called index.html
L f Js Use .jpg files for photographs, .png files if you want a transparent back-

w2 ground for a picture or button and .gif if you want an animated picture
(can also have a  transparent background but only limited colours)

L\/ When colouring images in other software e.g. Xara, Photoshop or Flash, use
™ r web safe colours, hexadecimal colours
- B

j}*:_ff Optimise pictures before putting them on web pages ... i.e. make them the

g right size (in pixels) and the file as small as possible to make sure they
load quickly before you insert them into your website.

Use tables to lay out the contents of a web page
Make sure text stands out clearly against the background of the page

Do not use too many flashing animated gifs

e Content

[ Golden rules when designing a website...
N « Design
B « Ease of use
C o Copywriting
T « Interactivity
. L e Use of technology
ufl r e Innovation
b= 4
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To create the buttons use the images provided in the images folder e.g.
S homebtn_1.png and homebtn_2.pgn. You will notice there are two images for each
I button, one image will be place on your page and when you hover with the mouse
over it, it will change to the second image and then when you click on it, it will navi-
gate you to another page.

Select the cell you B% Adobe Dreamweaver CS3 - [C:ADocuments and Settings\user\Desktoph.)
wish to insert your File Edit view Insert Modify Text Commands Site Window Help

button in, then se- | % = nsert comman
lect the image roll-

Layout | Forms | Data | Spry | Text | Faworites

over button from R = & E %'@':ﬁ'ﬁ@** =Y -
the top menu bar : :
image . image rollover

(COMMON) 9 b 9

Insert Rollover, Image >
Browse and insert the but- RS o
tonsyou Want and Ieave Criginal image: !images,l'homebtn_l.png ![Browse...]
the Ilnk empty at the mo__ Rollover image: |images,|'h0mebtn_2.png HBrowse... ]
ment. Click OK, repeat this Bl e i e
for all the other navigation Alternate text: | ]
buttons “hen clicked, Go ko URL: | | [ Browse. ..
To browse to see how your buttons work save your work first then select the =
Preview button and select preview in browser @,

The Internet Explorer browser will open and will display your web page, hover your
mouse over your buttons and you will see the button

i i the outline of a table C h a n g e

b7 Y You need to think about A A
} @) the layout and design of The Oscars
your website, here are ' s monen

some
e Sha Tin College News examples and on the next
= = A\ page are thumbnails of the

#{f | pictures in the images
[T folder

~ . TASK 6

pages will link to each other. You need to create a design on paper for the layout of your web-
site. It is important to think about how people will navigate from one page to the next.

From your website, there will be three links from the home page which go to the fol-
lowing pages:

e CAS

e The Concert

e The Oscars

%E;L You are going to consider the planning of your website, how each page will look and how the

You may decide that when you visit the Concert page for example, there may be
three further links to these pages:

e The Orchestra

e The Choir

e The Music
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These can be shown as a diagram known as a ‘Hierarchy Diagram’ (see below)
N Home Page

et The Concert The Oscars CAS

Orchestra Choir

Music

This diagram clearly shows that I will have three links coming from my home page
and so on.

Task 7

Now it is time to think about what pages you will need and how you will navigate to
them.

Design a Hierarchy Diagram for your own website. Choose appropriate software to
create your hierarchy diagram. (PowerPoint or Word) Print off a copy remembering
to add your name, class, date and Task 6 in the footer.

casa.jpg

homebtn_Z.png

oscarbtnl . png oscarbbnZ, png rockl.jpg rockz.jpg rockS.jpg

11
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HOMEWORK: TASK 8

W
g%;"’ﬁ Website Planning Sheet

1 Plan your web pages using the grid below, each square represents 40 pixels, mark out
your tables and where the images and buttons will go, don’t forget label the sizes of

~_each image and each cell of your table.
S 2 You can copy more website planning pages from you Student Resources folder
7[ {w_ 800 pixels wide

12
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TASK 9

Open up Dreamweaver and return to your home page

To create the other pages with a similar layout and to have the buttons in exactly the
same
place, it is easier to duplicate the index page, than redo each page from scratch!!

To duplicate the page select the index.htm page from the Files menu on the RH of the
screen. Then right click on the page and a submenu appears, select Edit and then

— Files [ N |z oscars)pg LERE LUK LI,
Ehcss (b ear s | |Local view L @ oscar3.jpg 30KB QuickTim,
i ) Application e[z rYae/® 0 @ [%] oscarbinipng  35KB PNG Imac
i b Tag Inspector Local Files | _size[type  [Modified W i e ,ﬂ oscarbtn2.png 35KB PNG Imac
— B3 site -Year 8 (C:\Doc. .. Folder  04/02/2008 18:31 Ml B rockijng 83KB QuickTim.
i ¥ Files D Images Folder  04/02/2008 18:31 B i )
= | @ indechmi mEmmET R seEn || rock2.jpg 38KB QuickTim,
lies NewFle [ W i i B rocks.jpg 32KB QuickTim,
(ED Year 8 w | |Local view gz::nlder ------ [%] rockbini.png 39KE PNG Imag
i = ; IR I [®] rockbinz.png F9KB PNG Imag
Local Fil E.s Size| Type Eut Eg::x: @ ...... |ﬂ sdogo.png 83KB PNG Imag
= ED me -Year 8 (C:\Doc... Folder I B —— EE RS O 26K8 PNG Imac
1, = =E= Folder Delete_Del gt N J index.himl 2B Firefox D
- - — T index.himl IKB Firefox D... VORI R 1 T
. Rename -
Ja )
TR ,
=
N select Duplicate. Select the newly copied page from the Files menu and select Edit

and Rename and give the new page a new hame (don’t forget to leave the .html/ tag
on the page)

- TULRLIU Lo g <IN P Lnayge
<body> <a|<img#cas>, - B |& Q |100% «|605x 357+ 36K /6 sec rodkbinZpng  39KB PNG Image
i ¥ Properties sclogo.png 83KE PNG Image
. title.png 26KB PNG Imaa:

Image, 353Ky (179 Src |Images/casbtnlpng |63 Alt v
% ges/ P 20 T indexhiml 2KE Firefox D,
as H|129 Link |cas.html iy - i P70 cas.html 2KB Firefox D.

Map V Space Target w | Border [0 E £ =

k| DOY H Space Low Src £¥ [  Align |Default »

To link the pages together, on the index page select the second button and the info

about the
<~ button will appear in the properties menu
f ‘ Next to the Link field there is a little clock, click and drag the arrow to the page you
T want to
P’ link to in the Files menu
&/ ¥ Save your work and preview in the web browser

o Continue to build up your pages for your website, you should complete 4 pages, the
o homepage,

__ CAS, The Concert and The Oscars. It is important that there is some consistency in the
.~ layout and style of the pages.

TASK 10

To make your site more interesting, use some of the additional material in the folder of images
And add some of the following

e Adding a repeating background (Modify menu >Page Properties >Background image
>Repeat)

Additional images - in the additional images folders on the staff drive

Buttons using text and rollovers

Adding the date/time to your website

Links to other sites e.g. STC
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TASK 11

7‘7‘ " 7 Peer evaluation

B s Using the table below open your website onto the computer, and ask four people to review it
E using PIM’s

N -

AN Name Positive Interesting Minus

] F
sai -~ Self evaluation
P In the space below complete the simple self evaluation statements, (think about the PIM’s
evaluation) add a printout of each of your pages from your website, using printscreen, and show
the files and layout of at least one page in Dreamweaver

Have I planned and created pages for my website?

Have I added appropriate text and images to my web pages?
L [ Have I planned and created hyperlinks to navigate through my web pages?
Have a evaluated my pages to make sure they were suitable for a wide audience?

.~ Can describe the steps I have worked through to create my web pages and suggest how they
can be improved?

Task 12

Word Search Homework
Revision, look at your word search for the key words
Test
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HOMEWORK TASK

This task is to be completed for homework.

u T vy U I H I E R A R H'Y A S D F G H J K
Q NWERTYHY P ER L I NK U I OP A S
D F I NDE X GH J K I L Z X C V B N MQW
E R T F DY UI O P A T B R OADDB A N D S
b F GHOJIKS L S Z EXAUCVBTNM~AQW
E R T Y WWRWUE I T ORUPANSDAUFGTH
J WK L N Z M A X Y CI V B ND I G I T AL
M E QWL ERRTILY AU I OPWASD B F
G B H J OI KL CUEUE Z XWUCVBNIT MQ LW
F S E R A TYHUS I OE P A S D F D S E G
/Il I M O D EMEMHMHOUJB OUDY TE X T K L
L T L 2z X C V NB E N UDBMAQWMHE R R HT
E E Y E I O P GAE S DI R FGHE J K UTL
S 2z X ¢ EvV B I NTMOQOT CWEMRTCTY
Il R U I O X P NA S D FWGEWHE J K TP L
Z O Z X C V T E B NMQ SWE L RTY U I O
E L P A UD I E NCUEAE S D F ONTR D F
G L HJ KL Z X NICVIBIRNMMOQWTCEERT
H OMEPAGEY S U I OP ASDFAGMH J
K v L Z X C VvV B NM I QWE L A Y OUTRT
Yy E U I O P A S DVF G OWH J KL Z X C V OB
R M N A V I G A I O NQ W E R T Y U I R
Web browser Bandwidth Website Tag
Uniform Resource Locator Search engine Navigation Rollover
Layout http Homepage Style sheet
Body text File extension Font File size
Download Hyperlink Modem Theme
Digital Index Broadband Audience
Hierarchy Table Criteria Structure

The file for the first page of a website must always be called ...... ?

The picture file-types you can use on a website are ...?

When you optimize a picture for a website you ...... ?

What should you use to help control the layout of a web-page?
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